Oral Communication (Grade 6)

1. Listening

2. Communicating

3. Reflection

1. Listening

Lyrics of a song: Implied Ideas, Extending Understanding, Point of View > Slide show (image reflect words), explain the point of view in the song

Reading Aloud: Active Listening, Comprehension > Collect, organize and summarize information using a template or software (Smart Ideas or Template) (Video > Nor’Westers Media Library 090272) 

· First Nation Peoples and European , 6z2 & 6z21 Social Studies: First Nation Peoples an European Explorers > Application – express their personal viewpoints, based on historical evidence e.g. watch the video Nor’Westers and do an Internet search, collect information and present the results on the Hudson’s bay Company or North West Company Trading Post.

· Why is this one of the most important eras and organizations in Canadian History?

Think/Pair/Share (Think Literacy page 152): Demonstrate Understanding, Analyzing Texts > in Math, solve a word problem together to better understand the task; compare their own responses to the problem first and explain what their partner wrote that makes the math solution effective and easy to follow

Video Inferences: Making Inferences/Interpreting Texts, Presentation Strategies >watch a video and answer the following questions; complete Effective Presentation Skills Template (Think Literacy page 196)

· What messages did you get from the speaker’s tone of voice/body language/facial expressions?

· How does paying attention to a speaker’s body language help you interpret what is being said?

· What type of presentation strategies did you see and were they effective?

· Etc.
2. Communicating 

Four Corners (four designated areas to select in the room): Interactive Strategies > Propose different questions/topic and place Agree/Strongly Agree/ Disagree/ Strongly Disagree posted in the four corners of the room. Students select one according to statements and a spokes person for each group will explain why; acknowledge different point of views; have students recognize that there are levels of formalities when speaking etc.

Presenting an Argument (Effective Presentation Skills): Clarity and Coherence, Appropriate Language, Vocal Skills and Strategies, Non-Verbal Cues and Visual Aids > Using the Website http://www.discovery.com/ select a topic from the Discovery News homepage and present an argument in favour of one point of view on an issue, with an opening statement, sequence of points with supporting evidence, and summary/ conclusion. (Students will be encouraged to use Smart Boards, Slide Shows, Website, and Charts etc. to present.)

3. Reflection 

Improving Oral Communication Skills: Metacognition > Discuss strategies to follow discussion (Think Literacy Page 178 -9); understanding information presented by taking effective notes (Think Literacy page 197 including posters). Compare and use formal and informal speaking when appropriate. Create Worksheet with examples or have students collect examples from their experiences and record on an electronic text format.

Making Connections: Interconnection Skills > Teacher prompts students with ‘How can your collection and organization of data help you to present it to an audience? Discuss jot notes, graphic organizers, databases etc..

Reading (Grade 6)

4. Reading for Meaning
5. Understanding Form and Style
6. Reading for Fluency

7. Reflecting on Reading Skills and Strategies
1. Reading for Meaning

Text Features Search (Think Literacy Pg 10): Variety of Texts, Purpose > Using the Suggested Prompts for a Text-Feature Search worksheet (pg 10) the students will examine a variety of texts. For example: Literacy Text (Poetry), Graphic Texts (Charts and Tables) and Informational Texts (Smart Computing Articles and Web Quests)

· Additional Learning> Determine which type of text would be effective to find specific information on a topic

Using Context to Find Meaning: Comprehension Strategies, Making Inferences/Interpreting and Demonstrating Understanding >

· Using Context to Find Meaning (Electricity pg 36-39) and Edison Software/Websites/Geography Examples (Understanding new terminology) 

· Inferences (Think Literacy pg 40-43) and Important/Not Important Information (Think Literacy pg 50-54)

· Using First Nation Peoples and European Explores, 6z1 & 6z4 Social Studies passages find the pertinent information needed (Think Literacy pg 46-47) For example, write point form a comparison of the Inuit and modern day travelers to the artic and read to the class.

 http://www.civilisations.ca/sitendx/sitendxe.asp
http://www.arcticvoice.org/index.html
http://www.nwt.worldweb.com/FeaturesReviews/TownCityReviews//8-163.html
· An Article will be examined for style, format, how information is presented etc. (Article is in Using Context to Find Meaning Folder)

I Read/I Think/Therefore (sample response Think Literacy pg 72): Extending Understanding, Responding to and Evaluating Texts and > Using the worksheet on page 72 and 73 students are encouraged to use the graphic organizer to read and respond to a particular text before drawing a conclusion. (Incorporate Social Studies topics.) .)  Video > Origins: a history of Canada - Programs 1 & 2043023,VH

· Describe the characteristics of pre-contact First Nation cultures across Canada 6Z1 Social Studies Expectation (What is their relationship with the natural environment?) http://www.civilisations.ca/vmnf/premieres_nations/en/index.html (See PDF documents created from this website in I Read I Think Therefore First Nations Folder.)

· Show video of Historical Explorers >Explorers I043144,VH

· Select 1 Explorer and research in detail their impact on the First Nations and European Peoples 6z3 (natural environment.) Compare this explorer to an individual today who has influenced our environment through exploring new lands.: (http://www.civilisations.ca/vmnf/explor/explcd_e.html) and http://www.mariner.org/educationalad/ageofex/biographies.php
Examples of 21st Century Explorers:

 http://www.explorationpodcast.com/
 http://ksnn.larc.nasa.gov/21Century/index2.html
http://www.kn.att.com/wired/21stcent/
· Extending Understanding: Now that you have researched both cultures, describe positive and negative effects of the early contact between First Nation peoples and European explorers. Suggest ways in which both sides could have made this transition become less disruptive for both sides.  6z2 Social Studies Expectation
Making Judgments and Reacting to Both Sides (Think Literacy pg 74-77): Point of View > Readers will increase their understanding by reviewing what they have read, reflecting on what they have learned, and asking questions about the significance.  

· Analyze examples of interaction between First nation peoples and European explores to identify and report on the effects of cooperation and the reasons for disagreements between the two groups

Clues for Finding Answers in the Text (Think Literacy pg 78): Analyzing Texts > analyze increasingly complex texts and explain how the different element in them contribute to meaning  

· Characters; characters, setting and plot

· Persuasive argument http://webquest.sdsu.edu/processguides/persuasive.html 

· Role of the summing-up paragraph in highlighting the most compelling points in the argument

· Provide sample essays to review and look for key elements and how they contribute to the meaning or theme.

2. Understanding Form and Style
Analyze Advertisements, Drawings, Logos, etc: Text Forms > Study graphic texts for meaning and purpose such as:

· An advertisement (e.g., how colour and layout are used to emphasize the appeal and importance of the product)

· Analyze Olympic products and logos

· First Nation Peoples and European Explorers 6z12 Social Studies (analyze Champlain’s drawings for effectiveness and meaning to help better understand the European Explores) etc.

· http://www.virtualmuseum.ca/English/index_flashFT.html 

· http://www.cbc.ca/news/background/champlainanniversary/timeline.html
· http://www.cbc.ca/news/background/champlainanniversary/tadoussac.html
· http://www.cbc.ca/news/background/champlainanniversary/tadoussac.html
· http://www.histori.ca/champlain/index.do;jsessionid=8272E80BB1F8C3E4921406A37DF6DB6E.tomcat1
· http://www.civilization.ca/vmnf/explor/champ_e1.html
· http://www.collectionscanada.ca/explorers/h24-1410-e.html
· http://www.histori.ca/champlain/search.do?config=htdig-cp-en&restrict=histori.ca%2Fchamplain%2F&words=drawing
Reading Maps (How are they organized to help the reader.): Text Patterns, Text Features and Canada’s Links to the World (Maps, Globe, and Graphic Skills) 6z43 Social Studies > Using the EdFiles CD compare various maps and analyze their differences and similarities, and features that help the reader. Organization is determined by Ideas (Think Literacy page 14, & 18 -19)

Map Websites:

· http://www.calgary-city-maps.com/ 

· http://www.fes.uwaterloo.ca/crs/geog165/mapdesign.htm
E.g., Different maps for different purposes.
Geographical maps such as 

· Canada maps 

· world maps 

· university campus maps 

· online maps such as Mapquest, Yahoo Maps and Map Blast (MSN) 

· entertainment and fun maps 

· bicycle maps 

· air photo maps 

· Geographic Information System GIS maps 

· Global Positioning System GPS maps 

· weather maps and forecasts 

· topographic maps 

· ecological and vegetation maps 

· lunar and other scientific maps

Hyperbole and complex Sentences to combine Information: Elements of Style > How does this help communicate meaning? (Think Literacy page 26-28)

Hyperbole is a figure of speech which is an exaggeration. Persons often use expressions such as "I nearly died laughing," "I was hopping mad," and "I tried a thousand times." Such statements are not literally true, but people make them to sound impressive or to emphasize something, such as a feeling, effort, or reaction

Activity:  Draw a cartoon about school or your favorite sport that includes a hyperbole (You might draw and exaggerate a humorous situation that you saw or were a part of the action.). Put the hyperbole in a different color so that it is obvious to your teacher. 
3. Reading with Fluency

Word Anchor Charts (Definition Links): Reading Familiar Words > Post terminology used regularly in discussion and later use a thesaurus to improve communication language. (Think Literacy page 33)

Presenting of Unfamiliar Words: Reading Unfamiliar Words >using semantic (meaning), syntactic (language structure) and graphophonic cues (phonological and graphic) each pair of students will select and present a detailed evaluation of the word.

New Anchor/Radio Announcement: Reading fluently> students will read a radio drama ‘War of the World’ or a News Cast to match the form and purpose. (Connie Smith, Cathy Wegner etc.)

4. Reflecting on Reading Skills and Strategies

Reflection Sheet: Metacognition, Interconnected Skills > Teacher prompts; 

· What writing activities helped you to read other unknown texts?

· http://www.bibliomania.com/0/0/frameset.html (Review the fiction books and explain the techniques used to give a quick introduction to the book.)

· http://www.bibliomania.com/0/0/frameset.html (Review an interview and explain the techniques used to in the interview and how the writing structure helps the reader to understand and follow the conversation.) Create on of your own.

· http://www.bibliomania.com/0/0/frameset.html (Review poetry and explain the techniques used to and how the writing structure helps the reader to understand and follow the poems ideas.)

Writing (Grade 6)

1. Developing and Organizing Content

2. Using Knowledge of Form and Style in Writing

3. Applying Knowledge of Language Conventions and Presenting Written Work Effectively

4. Reflecting on Writing Skills and Strategies

1. Developing and Organizing Content
Researching and Writing a Persuasive Essay (note: see activity in Reading (Reading for Meaning) and Persuasive argument Lesson: Purpose and Audience, Developing Ideas, and Research > students will develop and generate ideas about a potential topic to produce a persuasive essay > students will be encouraged to identify the steps required to gather information using appropriate copyright and referencing procedures.

· Persuasive argument http://webquest.sdsu.edu/processguides/persuasive.html
· Ten Steps to Writing a Research Paper http://library.ust.hk/serv/skills/libskill.html
· Seven Steps Research Process http://www.library.cornell.edu/olinuris/ref/research/skill1.htm
Organizing and Classifying Canada Links to the World (6z24 Social Studies Expectation): Classifying Ideas and Organizing Ideas > Students will use ‘Smart Ideas’ software to compare Canada’s economic, political, social and physical inks with the United States.

· Extended Understanding: Using the information you have gathered above write a short report on Canada’s influence on other regions of the world. You may select one area to focus on such as, political. (Think Literacy page 144-46 ‘Writing a Report’)

Determining if Information is Relevant, Appropriate and Adequate: Review > Students will organize and explain information with a partner to critically review.

Canada’s Links to the World (6z26 Social Studies Expectation): Students will select a current global issue and explain the relevance to Canada using Form (6e54 write longer and more complex texts etc.)

· Wind Energy

· Fuel Supply and Distribution

· World Population

· Literacy - Illiteracy

· Climate Change

· World Hunger

· Importing and Exporting

· Global Issues Organization  http://www.globalissues.org/
· Global Issues http://www.geni.org/globalenergy/issues/global/index.shtml
2. Using Knowledge of Form and Style in Writing
See Developing and Organizing Content Lesson: Form > Canada’s Links to the World (6z26 Social Studies Expectation): Students will select a current global issue and explain the relevance to Canada using Form (6e54 write longer and more complex texts etc.)

Compare Actors Facial Expressions to Punctuation: Voice, Word Choice and Sentence Fluency > Review a scene from silent films and stills and then use your knowledge of ‘Word Choice’ 6e56 to write the dialogue for scene.

· Extended Understanding: After viewing and writing the dialogue for the above silent film write a short synopsis of the scene using complex sentences (phrases, clauses etc.)

Word Processing (Computer Technology): Point of View, Preparing for Revision, Revision and Producing Drafts> 

3. Applying Knowledge of Language Conventions and Presenting Written Work Effectively
· Shared- guided and independent reading text while using/Spelling familiar words correctly (For example: After the Read Aloud in Guided Reading have the students synthesize while summarizing each segment in writing and adding their own ideas.)

· Spelling Unfamiliar Words: Understand the following>
· Sound-symbol relationships

· Word structures

· Word Meanings

· Generalizations about spelling

· Vocabulary:

· Use a thematic, homograph, print and homonym dictionary
· Use a thesaurus to explore alternative word choices 
· http://students.resa.net/stoutcomputerclass/2la.htm
· Punctuation: See Silent Films Section (Compare Actors Facial Expressions to Punctuation) in Using Knowledge of Form and Style in Writing
· Grammar:

· Object Pronouns (I, me)

· Indefinite pronouns (someone, nobody)

· Conjunctions

· Subordinate clauses

· Adverb phrases

· Past, present and future verb tenses

· http://students.resa.net/stoutcomputerclass/2la.htm
· Proofreading: Use an editing check list and use consistent symbols that indicate errors.
· Publishing and producing Finished Works: Effective presentation skills, incorporating multiple Medias and produce pieces of published work to meet identified criteria (e.g., adequacy of information and effectiveness of organization). 

4. Reflecting on Writing Skills and Strategies

Summarize your Writing Style: Metacognition and Interconnected skills > Students will research several writing style techniques and reflect on their own writing style.

· http://www.readwritethink.org/materials/lit-elements/
· http://grammar.ccc.commnet.edu/grammar/
· http://en.wikipedia.org/wiki/List_of_writing_techniques
· http://www.idrc.ca/IMAGES/books/WFC_English/WFC_English/sitemap.html
· http://www.gooddocuments.com/techniques/techniqueshome.htm
Writing Prompts: Metacognition > Students will use the technique of creating and using statements to encourage creative writing within the classroom community. 

· http://www.theteacherscorner.net/daily-writing-prompts/september/index.htm
· Using Microsoft Publisher or Word students will create several writing-prompts geared to many grade levels to share with peers and primary and junior schools.

Portfolio: Students will select pieces of writing and using the skills learned in researching writing techniques they will edit, reflect and develop the piece further.
